

    
      
          
            
  
Kdenlive 26.04 Manual

Welcome to the manual for Kdenlive, the free and open source video editor.

The current Kdenlive version you get here. Check out what’s new.

You can download this manual as an EPUB.
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新手入门

欢迎使用 Kdenlive！本章将帮助您快速上手使用 Kdenlive。

Introduction - This chapter talks about what Kdenlive is and is not, and some of the features you can expect

Installation - This chapter will cover everything from minimum system requirements to installing Kdenlive on Linux, Windows and MacOS

Quick Start - This chapter shows you step by step how to create a new project, add clips, work with the timeline, add effects and music, and finally how to render your project into a video

Tutorials - This chapter contains links to written tutorials and video tutorials on YouTube

Configuration - This chapter describes the various configuration settings available in Kdenlive to adapt it to your preferences and editing workflow







            

          

      

      

    

  

    
      
          
            
  
用户界面

本章节将介绍 Kdenlive 用户界面 (UI)，解释各种 元素，图标，按钮，菜单选项，可加快编辑工作的默认 键盘快捷键，以及如何 自定义布局 以适应特定的后期制作流程。

启动 Kdenlive 后，窗口应与下图类似。Kdenlive 的用户界面 (UI) 在所有平台上都是一致的，因此无论您的操作系统是 Linux，Windows 还是 MacOS 都没有关系。当然，图标和文本看起来会有所不同。

用户界面分为四个主要部分：

[A] The Workspace with the various widgets that can be arranged to your needs. See the 视图菜单 and 工作区布局 for more details.

[B] 菜单栏，包含 菜单 和 工作区布局 列表。

[C] 菜单栏下方，以及 时间轴 上方的 工具栏。

[D] 屏幕底部的 状态栏。


[image: _images/kdenlive2304_ui-screen_layout.webp]

Kdenlive 的默认屏幕布局 (以编辑视图为例)：菜单栏 (蓝色)，工具栏 (黄色)，工作区 (绿色) 和状态栏 (红色)。



工作区

工作区模式遵循视频编辑流程，可根据个人风格和偏好进行调整。默认情况下，Kdenlive 以编辑工作区模式启动，如下所示：


[image: _images/kdenlive2304_ui-workspaces.webp]

Kdenlive 的默认工作区 (以编辑视图为例)




	[1] 项目素材箱，素材库:

	This is where you keep your source files (video clips, images and image sequences, title and color clips, animations, audio files). In this screenshot the widgets for Undo History, Compositions, and Effects have been added to this section.



	[2] 剪辑监视器:

	这里显示在项目素材库中选择的素材。在本截图中，Library 窗口部件的已添加到此部分。详情请参阅 剪辑监视器 一章。



	[3] 项目监视器:

	This is where the content of the timeline is being displayed with all effects and compositions applied. In this screenshot the widgets for Speech Editor and Project Notes have been added to this section. See the chapter 项目监视器 for more details.



	[4] 时间轴:

	Most of the action is taking place in the timeline. Here you put your sources in the order in which they will appear in the final video, make your edits (cuts and trimmings), apply effects, add compositions and transitions, and add audio and sound tracks. See the chapter 时间轴 for more details.



	[5] 时间轴工具栏:

	在这里您可以找到编辑视频项目所需的所有工具。详情请参阅 时间轴工具栏 一章。



	[6] 混音器:

	这部分是 音频混音器面板，您可以在此控制各音轨和主音轨的音量和左右声道平移。



	[7] 菜单栏，工具栏:

	在屏幕顶部，您可以访问菜单 (详见 菜单栏 和 菜单)，工作区布局 和 主工具栏。可以使用 Ctrl+M 打开或关闭菜单栏。



	[8] 状态栏:

	根据鼠标指针悬停的位置，Kdenlive 会在状态栏左侧显示特定上下文信息或提示。在中间位置，您会看到时间轴上悬停的片段名称。在时间轴中处理剪辑时的错误信息也会出现在这里。在右侧，Kdenlive 会显示当前选择的时间轴 编辑工具，以及各种启用/关闭时间轴功能的图标。更多详情，请参阅 状态栏图标 和 状态栏 章节。











            

          

      

      

    

  

    
      
          
            
  
Project and Asset Management




Kdenlive works with projects. A project contains all the assets (sources), the timeline with your clips in different tracks, the cuts and trims, compositions and transitions, annotations, markers, timeline marker - in short, everything you and Kdenlive need to produce a video file as the result of your work.


提示

When creating a project, select a project profile with the final video in mind. The project settings determine the resolution (e.g. 1920x1080), the frame rate (e.g. 25 fps), other metadata, and how to deal with the project’s assets.




备注

You can change the project profile later but it is not recommended as it may lead to undesirable results, in particular when you use keyframes.



The Project Bin holds all your assets. You can load (or import) video and audio files, single images or entire image sequences, create color and title clips, animations, and download assets from various online sources directly into your project.

While the project bin is for a specific project, you can use the library feature to store assets for use in other projects. That is also the only way to share or copy assets between projects.

Kdenlive offers limited video and audio capturing functionality, for example to create voice overs, or use screenshots.

You can take notes for your project that capture timestamps for easy reference during the editing process. This is very useful for big and complex projects or productions.

Kdenlive has an auto-save feature, creates backups in the background, and allows to archive a project with all the assets included.




            

          

      

      

    

  

    
      
          
            
  
剪辑与拼接







            

          

      

      

    

  

    
      
          
            
  
Effects and Filters

Effects and Filters are very important components in video editing. In Kdenlive, effects and filters are provided by frei0r or avfilter (Kdenlive does not have built-in effects or filters of its own).

效果用于更改剪辑的外观或对其进行操作。例如，Transform 效果允许缩放和移动剪辑； Brightness 效果更改剪辑的亮度；Alpha, Mask and Keying 类别中的效果提供了用于遮罩或旋转示波器的非常具体的过滤器。

Kdenlive 有两个效果组: 视频效果 和 音频效果

有几种方法可以将效果应用于剪辑:


	在项目素材箱中，该效果可用于时间轴中该剪辑的所有实例


	在时间轴中，该效果只适用于时间轴中该剪辑在该点


	在轨道上，该效果应用于该特定轨道中的所有剪辑


	在主音上，该效果应用于所有轨道中的所有剪辑





备注

并非所有效果都可以在轨道或主音级别使用，也不需要这样做。




Built-in Effects

The built-in effects are disabled by default. So you have to enable it before you can use it.

All built-in effects can be disabled/enabled globally in Settings ‣ Configure Kdenlive -> Misc


[image: _images/kdenlive2412_builtin-effect_disable.webp]

Under Misc you can disable/enable all built-in effects. Default is disabled.



When dragging a clip into the timeline, the Flip and Transform effects are always added to the video part of the clip; for the audio part the Volume effect is added by default.

These are the most used effects which you now have at your fingertips without the need to add them manually.

[image: video-effect] < video part | audio part > [image: audio-effect]

Built-in effects can be used in four places:


	on a clip in the project bin (Transform and Flip, audio part: Volume)


	on the timeline when a clip is clicked (video part: Transform and Flip, audio part: Volume)


	on the track header (only Flip on video track and Volume on audio track)


	as master effect (only Flip and Volume)






效果选项卡

在 菜单 ‣ 查看 ‣ 效果 中显示效果选项卡。

The Effects widget has eight control icons that show or hide the different effect categories:


[image: _images/kdenlive2412_effects_tab.webp]

Kdenlive 效果选项卡在项目素材箱区域



[image: show-all-effects]Main effects shows all video and audio effects (default view)

[image: kdenlive-show-video]Show all video effects shows all video effect categories only

[image: kdenlive-audio]Show all audio effects shows all audio effects categories only

[image: kdenlive-custom-effect]Show all custom effects shows all effects you have created by saving an effect stack.

[image: favorite]Show all favorite items shows all effects that were flagged as a favorite effect. This is the same list that appears when selecting Insert an effect from the right-click menu of a clip in the Timeline, or by clicking the Favorite Effects in the Timeline toolbar.

[image: edit-download]Download New Effects opens a dialog window where effect templates are listed from the KDE Store

[image: view-filter]Only show reviewed assets toggles between the effects which are reviewed and tested by the Kdenlive team and not tested effects (still in test phase).
Show 10 bit compatible only it hides assets not compatible with a 10-bit pipeline. Use the 10 Bit category or the NVENC H265 ABR 10 bit codec for rendering.

[image: help-about]Show/hide description of effects toggles the information display below the effect list where a short description of what the effect does is displayed when on. Click on the blue effect text opens the online documentation to this effect.



效果/组合堆栈

这个小部件也被称为属性选项卡，因为它列出了当前选定剪辑应用的所有效果，以及每个效果的设置或属性。如果选择了一个组合，则小部件显示组合的设置或属性。

[image: effect] < 效果 | 合成 > [image: composition]


备注

只有效果可以堆叠，合成不能。




效果/组合堆栈功能


[image: _images/kdenlive2304_effects-effect_stack.webp]

Kdenlive效果堆栈



[image: document-save-all] 保存效果 - 打开一个对话窗口，用于输入效果堆栈的名称，该名称将在 自定义 效果类别中列出，并显示一个注释，该注释将在信息显示中显示

[image: view-split-left-right] 比较效果 - 将预览监视器垂直分割，以便比较剪辑与无效果的剪辑

[image: visibility] 效果启用 - 切换效果堆栈的开关。这相当于在效果堆栈中禁用所有效果。

[image: keyframe-disable] 在时间轴中隐藏/显示关键帧 - 切换在时间轴中的剪辑中显示关键帧的开关

当效果应用于时间轴中的剪辑时，您可以在效果按钮上单击以启用/禁用该剪辑的剪辑堆栈。当禁用时，剪辑上的效果名称是划掉的。


[image: _images/kdenlive2402_effects-effect_stack_disabled.webp]

点击剪辑的效果时，Kdenlive效果堆栈被禁用





效果功能


[image: _images/kdenlive2412_effects-effect_panel.webp]

Kdenlive效果面板




	1:

	[image: go-down] Expand/collapse the effect panel. Shift + click to expand/collapse all effects

[image: keyframe-disable] 隐藏/显示关键帧 - 打开或关闭关键帧标尺的显示

[image: zoom-fit-width] Use effect zone - Toggles the display to show the effect zone

[image: visibility] 禁用效果 - 打开或关闭效果。效果仍然保留在堆栈中，但在播放或渲染期间不应用。

[image: adjustlevels2] Presets - Opens a list of advanced options to manage presets for the effect (e.g. reset the effect to its default parameters).

[image: document-save] 保存效果 - 打开一个对话窗口，用于输入效果的名称，以便将其列在 自定义 效果类别中，并显示一个注释，该注释将在信息显示中显示

[image: help-about] Open effect documentation in browser  - This opens the online documentation to this effect

[image: selection-raise] 移动效果上升 - 将效果向上移动一个等级（效果序列从顶部到底部很重要）

[image: selection-lower] 移动效果下降 - 将效果向下移动一个等级（效果序列从顶部到底部很重要）

[image: edit-delete] 删除效果 - 从效果堆栈中删除效果

arrow up/down goes to the next effect in the list



	2:

	Effect function with check box only



	3:

	Effect function with selector



	4:

	Effect with keyframes



	5:

	
	Effect values and action button ([image: object-rotate-right]).


	The tooltip Support basic math expression shows if the following basic math functions are possible:
+ - * / ( ). It doesn’t follow standard order of operations:
multiplication (×) and division (÷) must be performed before addition (+) and subtraction (-).
For standard order of operations you have to use parentheses ( ).


	The tooltip use “%…” to reference other spinbox’s value shows which other parameter you can use in the formula:
positions, size, scale, opacity, number of value field
(use %x %y %w %h %s %o %1-n).
If an effect has several fields with the same type of value, it shows a number like %3.
You can add a basic math to that link like: %y*2


	If an effect has a timecode field, you can add or subtract time by starting with + or -.
The format is [+/-]hh:mm:ss:ff. You can add time in short form:



	1:: adds/subtracts 1 hour 1:00:00:00


	2: adds/subtracts 2 minutes 00:02:00:00


	12. adds/subtracts 12 seconds 00:00:12:00


	9 adds/subtracts 9 frames 00:00:00:09


	2:.9  adds/subtracts 2 minutes and 9 frames 00:02:00:09









	Reset value to default by clicking with the MMB [3] on the slider or value.











应用效果


那里可以应用效果

一个效果可以在你项目的四个不同级别上应用：


	On a clip in the timeline: it will affect only this clip


	On an clip in the bin: it will affect all the occurrences of this clip in the timeline


	On a track: it will affect all the clips on this track


	On the Master: it will affect your global output






如何应用一个效果

对于将效果应用于剪辑的剪辑或时间轴上，你可以从效果选项卡中选择一个，并将其拖动到剪辑上。

You can also double-click on an effect in the Effects Tab which adds the effect to the clip in the Project Bin which appears in the clip monitor. In the Timeline, it adds the effect to the clips which are selected. So you can apply an effect to several clips at once in the timeline.

另一种方法是使用时间轴工具栏中的 [image: favorite] F收藏效果 图标，并从那里选择效果（您可以通过右键单击效果选项卡中的效果并选择 添加到收藏 将效果添加到收藏夹中）。

Alternatively, you can use Menu ‣ Sequence ‣ Add Effect to select an effect from the various categories and add it to the selected clip(s) in the Timeline.

最后，您还可以从任何剪辑（时间轴或项目板）复制所有设置的效果，并将其粘贴到其他剪辑中。

对于将效果应用于轨道，请参阅 轨道效果

对于将效果应用于主音，请参阅 主音效果


备注

Effects are always added at the bottom of the effect stack, and since the effect order is important, can be re-arranged.






效果中的关键帧

许多效果都使用“关键帧”的概念。关键帧是剪辑中用户定义的点，您希望在效果开始、停止或更改时使用效果。您可以在不同的关键帧上设置效果的参数，以便在视频到达下一个关键帧时，Kdenlive 将逐渐改变参数，以便在到达下一个关键帧时，参数将适应该关键帧。它插值关键帧。


关键帧类型，插值

Select the keyframe interpolation icon for selecting the keyframe type. See 快速入门 for an example on keyframing the RGB adjustment effect.


[image: _images/kdenlive2402_effects-keyframe_types.webp]

Kdenlive关键帧类型



The first three keyframes are: Linear, Discrete and Smooth (Centripetal Catmull-Rom spline interpolation). This are standard keyframes. More details about keyframes are here.

接下来的十个关键帧是缓动关键帧，其计算基于罗伯特·彭纳的方程式[2] 。

现实生活中的物体不会立即开始和停止，而且几乎从不以恒定速度移动。当我们打开抽屉时，我们首先以快速速度移动它，然后将其减慢速度，直到它出来。将某物放在地板上，它首先会加速向下，然后在撞到地板后反弹回上方。

缓动关键帧： 左端是运动的开始，蓝色和绿色段代表更快的运动。


[image: _images/kdenlive2402_effects-ease-bounce.webp]


[image: _images/kdenlive2402_effects-ease-cubic.webp]


[image: _images/kdenlive2402_effects-ease-exponential.webp]


[image: _images/kdenlive2402_effects-ease-circular.webp]


[image: _images/kdenlive2402_effects-ease-elastic.webp]

平滑（已弃用）： 是在Kdenlive 24.02之前平滑的Catmull-Rom插值关键帧。



关键帧标尺

关键帧标尺具有缩放栏，如果剪辑的持续时间相对较长，并且效果堆栈小部件太窄，无法整齐地显示所有关键帧，则调整关键帧会更容易。


[image: _images/Zoombar-effects.gif]


[image: _images/keyframe_toolbar_copy-paste.png]

Keyframes can be copied and pasted between effects and even across clips using the standard shortcuts Ctrl+C, Ctrl+V



Keyframe Curve Editor

Implemented with version 24.08 the keyframe curve editor is still in alpha state. Improvements will come with upcoming versions.

The curve editor is showing the keyframe type and their curves.


[image: _images/curve-editor_enabling.webp]

To switch to the curve editor click on [image: switch-to-curve-editor-view]Switch to curve editor view.

The curve editor can only be enabled on effects which have the following parameters: X, Y, width, height, opacity (alpha, optional) and rotation. For all other effects the curve editor is greyed out.

By double clicking into the window new keyframes get added. Hovering over a keyframe, the cursor changes to a cross and you can:


	move the keyframe to change the value, depending on which tab you are (X position, Y position, Width, Height, Opacity, Rotation). Hold Ctrl moves the keyframe vertically only.


	click on the keyframe and change the keyframe type





[image: _images/curve-editor_example-view.webp]

In this example, the cursor enables the second keyframe and you can either change the values by moving the keyframe or change the values directly in the boxes below the curve editor view.


[image: _images/curve-editor_switch-back.webp]

To switch back to the timeline view click on [image: switch-to-timeline-view]Switch to timeline view.



在效果堆栈中使用关键帧

The effect keyframe panel allows comprehensive manipulation of keyframes:


[image: _images/Move-kf-to-cursor.gif]


	选择要移动的关键帧


	将光标移动到您希望将关键帧移动到的位置


	点击 [image: align-horizontal-center] 将选定的关键帧移动到光标






[image: _images/Duplicate-keyframe.gif]


	选择要复制的关键帧


	点击 [image: edit-copy] 复制关键帧


	将光标移动到您希望插入新关键帧的位置


	点击 [image: edit-paste] 粘贴关键帧








[image: _images/Apply-value-to-selected-kf.gif]


	选择您想要应用值的全部关键帧


	转到选定的关键帧之一，并根据需要更改值(s)


	点击 [image: application-menu] 选项 并选择 将当前位置值应用于选定的关键帧


	选择您要应用的参数，然后点击 确定








[image: _images/Kf-ctrl-select.gif]

Select multiple individual keyframes with Ctrl+LMB





[image: _images/Kf-rubber-select.gif]

Select contiguous keyframes with Shift+LMB





[image: _images/Multiple-kf-move.gif]

同时移动多个关键帧





Keyframe Types

Easing functions are based on Robert Penner's Easing Functions.



交换效果之间的关键帧

你可以从/向剪贴板导入和导出关键帧。这个功能不仅仅适用于从一个剪辑复制关键帧到另一个剪辑，还可以用于例如将运动跟踪器的结果复制到变换效果。

要导出关键帧到剪贴板，请点击关键帧面板中的[1] [image: application-menu] 选项 并选择 复制关键帧到剪贴板


[image: _images/Kdenlive_import_keyframes_dialog.png]

导入关键帧



要导入剪贴板中的关键帧，请点击关键帧面板中[1]  的 [image: application-menu] 选项 并选择 从剪贴板导入关键帧。如果您在剪贴板上有有效的数据，您应该会看到这个对话框窗口，您可以在其中调整数据的映射。

在大多数用例中，默认设置就足够了。但您可能只想复制一部分数据，也许要输入一个偏移值，例如。




轨道效果


[image: _images/kdenlive2304_effects-track_effect.webp]

轨道效果指示器



效果可以添加到整个轨道，影响该轨道中的所有剪辑。只需从效果标签页中拖动一个效果到所需轨道的标头，或单击 [image: tools-wizard] 轨道效果 图标，并将效果拖到轨道效果堆栈中。



主效果

如果你想在整个视频中应用音频或视频效果。点击轨道标头上面的 主 按钮，以查看主效果堆栈，您可以在其中添加效果，就像使用剪辑或轨道一样。


[image: _images/master.gif]

添加复古褐色效果到整个视频



只有特定的效果和过滤器才能在 主效果 工作。



效果区域

效果区域允许您将效果应用到轨道或时间轴中的特定区域。区域可以从时间轴中的效果区域栏设置，也可以从效果面板中的界面设置。


[image: _images/Track-effect-zone.gif]

轨道效果区域




[image: _images/Timeline-effect-zone.gif]

主效果区域





遮罩效果

该功能允许通过使用遮罩仅将效果应用于剪辑的特定区域。在当前实现中，该过程需要三个步骤：


	添加其中一个可用的遮罩：形状透明度（遮罩）、旋转扫描（遮罩） 或 透明形状（遮罩）。


	添加一个（或多个）效果（或效果）应用于遮罩区域


	添加 应用遮罩 效果以激活步骤2中的效果的遮罩





[image: _images/mask.gif]

使用旋转扫描（遮罩）仅在一个特定区域中应用饱和度效果

您可以按照相同的三个步骤为一个剪辑应用多个遮罩。



视频效果

视频效果分为以下几个类别：



	Alpha, Mask and Keying

	Blur and Sharpen

	Color and Image Correction

	Custom Effects

	Generate

	Grain and Noise

	Image Adjustments

	其他效果

	Motion

	On Master

	Stylize

	Transform, Distort and Perspective

	Utility

	VR360 and 3D

	Deprecated Effects





可用的效果由 .xml 文件定义，这些文件位于 .local/share/kdenlive/effects （例如 /usr/share/kdenlive/effects）。

这些 .xml 文件包含 Kdenlive 中效果参数的默认值。因此，如果您不喜欢 Kdenlive 中效果的默认值，您可以修改这些 .xml 文件。

See also here for an alphabetical list of effects and filters.



音频效果

音频效果分为以下几个类别：



	Audio-音频效果

	Channels-通道

	CMT Plugins-CMTT插件

	EQ and Filters-EQ和滤波器

	LADSPA Plugins-LADSPA插件

	Modulators-调制器

	Pitch and Time-音高和时间

	Reverb, Echo and Delays-混响、回声和延迟

	Steve Harris’ SWH Plugins-Steve Harris的SWH插件

	Stereo and Binaural Images-立体声和双耳图像

	TAP Plugins-TAP插件

	Tools-工具

	Volume and Dynamics-音量和动态





可用的效果由 .xml 文件定义，这些文件位于 .local/share/kdenlive/effects （例如 /usr/share/kdenlive/effects）。

这些 .xml 文件包含 Kdenlive 中效果参数的默认值。因此，如果您不喜欢 Kdenlive 中效果的默认值，您可以修改这些 .xml 文件。

See also here for an alphabetical list of effects and filters.



Alphabetical List of all Effects and Filters



	Alphabetical List of Effects and Filters







音频工具



	音频工具







时间重映射

时间重映射功能允许对剪辑的速度进行关键帧操作，以实现速度渐变等效果。


[image: _images/timeremap.gif]

使用时间重映射进行速度渐变的示例



See also this tutorial.



语音转文本



	语音转文本







普通字幕



	Subtitles







效果演示

以下三个 YouTube 视频显示了 Kdenlive 中可用的视频效果的效果演示（西班牙语字幕）。


	https://youtu.be/C6oeu2Yc64I


	https://youtu.be/jrC4F_G64jAg


	https://youtu.be/XMoSgHHbA4k




其他 YouTube 视频 (英文字幕)。


	https://youtu.be/capV7lUzbOw




参看这个 YouTube 播放列表 Franz M.P.





[1]
(1,2)
如果你看不到关键帧面板，请检查是否已经关闭了此效果的关键帧面板（效果工具栏中的 [image: keyframe-disable] 图标）或者也许此效果不支持关键帧。



[2]
Robert Penners 方程：http://robertpenner.com/easing/



[3]
MMB = Middle Mouse Button (mouse wheel pressed), RMB = Right Mouse Button







            

          

      

      

    

  

    
      
          
            
  
转场与合成

合成是将来自不同来源的多个视觉元素组合成单个视频的过程。其涉及使用其他素材 (通常是其他图像或视频) 替换图像或视频的选定部分。

To create a composite from several clips, you make parts of one or more of the clips transparent so that the other clips can show through. Alpha shapes, rotoscoping, and masks are the most common features for making portions of the clips transparent.

You can use the Opacity parameter in the Transform effect to control uniform transparency of a clip. This can be animated using keyframes to fade a clip down or up over time.

某些片段可能在其 Alpha 通道中存储了透明度信息。您可以在合成过程中告诉 Kdenlive 如何使用此信息。以下文件格式可能包含 Alpha 通道：


	图像文件格式:

	EXR, PNG, APNG, TIFF, GIF, SVG, JXL



	视频文件格式:

	MOV, HEVC, WEBM





合成两个以上的片段需要在多个轨道之间进行合成，或者组合使用 Alpha 通道和遮罩。

在 Kdenlive 中，您需要将不同的素材放入**时间轴**中的轨道，并使用**合成**来告诉 Kdenlive 如何将它们组合在一起。例如，“溶解”合成滤镜会在一定帧数内淡出一个片段的同时淡入另一个片段。

这就是为什么：Compositions-合成 通常被称为 转场。


备注

Alpha 通道会自动进行计算，因此带有 Alpha 通道的片段可以互相叠加，而无需使用合成。









            

          

      

      

    

  

    
      
          
            
  
导出

在 Kdenlive 中导出意味着渲染，反之亦然。渲染将项目的时间轴与所有编辑的剪辑转换为最终产品：一个单独的完整视频文件。

Kdenlive 使用 预设 或 渲染属性 来控制或确定导出。您可以创建自己的预设和配置文件。

Hit Ctrl+Return to open the rendering dialog or use the Menu ‣ File ‣ Render and click on the render button [image: media-record].


[image: _images/kdenlive2212_rendering-render_dialog.webp]

渲染对话框




	选择 导出文件 位置


	选择所需的 预设。MP4-H264/AAC 几乎可以在任何地方工作。


	单击 导出为文件 按钮。




一旦视频被渲染，你可以双击带有文件名的蓝色横幅来启动播放。


[image: _images/kdenlive2402_rendering-window.webp]

渲染完成后窗口



或者右键点击文件名，以 添加到当前项目 或 打开所在文件夹 来保存视频。







            

          

      

      

    

  

    
      
          
            
  
疑难解答

This section tries to help fixing issues you may encounter when installing or using Kdenlive. If your specific problem cannot be solved here try to reach out to the Kdenlive community on Discuss, Telegram, r/kdenlive[1] or Discord[1].

Please do not hesitate to log a bug report if you cannot get a problem resolved.





[1]
(1,2)
This site/channel is privately maintained and not an official Kdenlive site or channel









            

          

      

      

    

  

    
      
          
            
  
术语表(Glossary)


	Active Track(活动轨道)
	可以接受剪辑。用高亮的轨道号码表示。



	Asset
	An asset is any multimedia file (video, audio, image), title clip, color clip, and animation that can be and is used in a project. All assets are listed in the Project Bin.



	Audio Mixer(音频混音器)
	显示音量指示器和控制相应音频轨道音量的滑块的小部件。请参阅 音频工具。



	Audio Track(音频轨道)
	在 时间轴 中的轨道，其中包含视频剪辑的音频 流 或音频文件本身



	Backup(备份)
	Kdenlive creates backup files for the current project. They are stored in a special folder. See the chapter Backup.



	Bin(箱)
	参看 项目素材箱



	Caret(光标)
	参看 播放头



	Chroma(色度)
	Chrominance(色度)
	视频系统使用的信号，用于传达画面颜色的信息。色度通常表示为两种彩色差分组件：U（蓝色投影）= B’ - Y’（蓝色 - luma）和V（红色投影）= R’ - Y’（红色 - luma）。请参阅 YUV。



	Clip Monitor(剪辑监视器)
	剪辑监视器播放当前选定的剪辑 项目素材箱 。请参阅 监视器 和 覆盖 。



	Clip(剪辑)
	Essentially any file with video and/or audio, a simple image or any asset created through Kdenlive, e.g. title clip, color clip, animation (via Glaxnimate). A clip can be in the Project Bin or Timeline, or be referred to as the result of a Render. See chapter Add Clip or Folder



	CMYK
	基于 CMY 颜色模型在打印中使用的减色模型。缩写指的是四个墨水版：青色、品红色、黄色和关键（黑色）。



	Codec(编码)
	编码器的简称。是一种硬件或软件过程，用于压缩或解压缩大量数据。例如 MPEG、H.264、VP8/VP9、Apple ProRes。不要与 容器 混淆。



	Color and Image Correction(颜色和图像校正)
	调整或更改剪辑颜色成分的效应和过滤器的类别。



	Color Correction(颜色校正)
	颜色问题的修正过程，并使素材看起来像人类眼睛在真实世界中看到的那样自然。这个想法是让图像看起来像人类眼睛在真实世界中看到的那样自然。



	Color Grading(颜色分级)
	在电影中创建一致的颜色色调的过程，以便给它一个特定的美学外观和风格。



	Color Matrix(颜色矩阵)
	描述了在捕捉中创建准确表示的不同颜色光谱部分的平衡，以便进行调整。通过调整颜色矩阵的属性，您可以执行诸如调整白平衡、更改颜色调色板、调整源中的颜色异常等操作。



	Color Range
	A term with more significance in broadcasting. Today’s video recording equipment records in full range. Each color component is 8-bit and can have a value from 0 to 255, but only when in full range. Otherwise, for allowing headroom for video processing and exposure ranges, ranges are smaller, like 16-235 for luma, and 16-240 for chroma.



	Color Space (色彩空间)
	色彩空间是一种颜色的特定组织。它是理解特定设备或数字文件的彩色能力的有用概念工具。当试图在另一个设备上重现色彩时，色彩空间可以显示阴影/高光细节和颜色 饱和度 是否能够保留，以及保留的程度。查看维基百科中关于 color space 的这篇文章。



	Composition(合成)
	Also referred to as a transition, it combines at least two input clips to one output clip. Compositions cannot be stacked. See chapters Compositions-合成 and 转场.



	Container(容器)
	Container Format(容器格式)
	A type of file that encapsulates multiple (compressed) data streams in one file (wrapper), usually together with metadata for identifying or further detailing the embedded streams. Examples are Matroska (.mkv), OGG (.ogg), MPEG-4 (.mp4), AVI.



	Crash(崩溃)
	当你意识到你没有保存你的项目至少两个小时，并在最困难的编辑上工作的时候。参阅 备份 。



	Deprecated(已弃用)
	过时，不再使用。 Deprecated 类别中的效果仍然可用，但不再维护，可能会导致意外的结果。



	Dynamic Text(动态文本)
	一个可以应用于 剪辑 、 轨道 或在 主轨道 上叠加视频的特殊效果。可用的关键字是：timecode，frame，filedate，localfiledate，source frame rate，source codec，source bit rate，source width，source height，source comment



	Edit Mode(编辑模式)
	项目监视器 的一个特殊功能。需要能够使用鼠标来操作某些效果（如Transform、Rotoscope）的某些方面（如大小、位置）。可以使用项目监视器的工具栏中的 [image: edit-mode] 图标开关打开和关闭。



	Effect(效果)
	也被称为 过滤器 ，效果用于改变 剪辑 的外观、大小或位置。大多数效果都有 关键帧 功能。可以在同一个剪辑上使用多个效果（叠加）。在这种情况下，效果是从上到下处理的，因此顺序很重要。参阅 效果-效果堆栈 。



	Exporting(导出)
	参看 渲染



	Field Order(场顺序)
	也被称为 Field Dominance(场优先) 。确定在视频流中哪个场（field）首先出现。参阅关于 Field Order 的这篇文章。



	Filter(滤镜)
	Kdenlive 使用来自 avfilter 和 frei0r 的滤镜来修改帧。参阅 效果 。



	FPS(帧率)
	每秒帧数
	Frame Rate(帧率)
	每秒帧数（FPS）表示为帧/秒或FPS。帧率通常表示连续图像（帧）的捕获或显示频率（速率）。有关不同类型的视频的典型帧率列表，可以在 techsmith.com 上找到帧率速成课程。



	Gamma(伽马)
	Gamma Correction(伽马校正)
	一种描述颜色值与特定设备亮度之间的关系。因此，伽马校正是将 亮度 编码和解码为人类看到的彩色色调的非线性操作。



	Histogram(直方图)
	显示视频亮度颜色分量的频率直方图。请参阅 视图菜单，特别是 How the Histogram Works 以获得更详细的底层视图。



	Hue(色调)
	表示颜色的亮度、黑暗或强度。与 饱和度、 色调 和 阴影 进行比较。



	Icon(图标)
	表示动作、功能、选项或状态的图形表示。



	In-point(入点)
	入点 定义了一个 区域 的开始。可以在 时间轴 和 项目监视器 中定义一个区域（它具有相同的结果），或者在 剪辑监视器 中定义（对于仅将一个 剪辑的部分移动到时间轴非常有用）。请参阅 区域 以了解可能的用法。



	Inactive Track(非活动轨道)
	不能接受剪辑。用灰色的轨道号码表示。



	Interlaced(隔行/交错)
	Interleave(隔行)
	一种在不使用额外带宽的情况下将视频的感知帧率加倍的技术。与 逐行 进行比较。请参阅关于 Interlaced Video 的此维基百科文章。



	Jog Shuttle(摇杆)
	An external device that improves video editing by using a rotary knob to scrub through the timeline, and providing a special keyboard for actions like cutting, inserting, deleting, slip and ripple editing, etc. It can be used with Kdenlive and configured in Menu ‣ Settings ‣ Configure Kdenlive ‣ JogShuttle. See Settings.



	KDE Store(KDE 商店)
	An online app store where users can upload files like lumas for wipes, presets for rendering, title templates, library clips and even project files. See 效果选项卡 icon #7.



	Kelvin(开尔文)
	Kelvin 是国际单位制（SI）中温度的基本单位。它也被用作光源的颜色温度的度量。真实故事：一位物理学家将自己冷却到-273.15摄氏度。他是0K。。



	Keyframe(关键帧)
	定义剪辑中的帧，其中某些事情开始或改变。大多数 效果 都有关键帧，以允许随时间的变化。例如，变换效果的 X 和 Y 坐标可以被关键帧化，以在屏幕上移动剪辑。请参阅 效果-使用关键帧。



	Layout(布局)
	一个特定方式小部件在屏幕上排列，以支持不同的工作流程或任务。Kdenlive 可以在记录、编辑、音频和颜色中保存不同的布局。请参阅 工作区布局。



	Library(库)
	Holds assets for generic use in projects. For example, watermarks, logos, lower-thirds, intros, and so on. See the chapter Library.



	Lightness(亮度)
	也被称为亮度，亮度是白色或黑色与颜色的混合量。亮度(Lightness)是一种主观的测量方法，而亮度(brightness)是一种绝对的测量方法，用于测量从物体发射或反射的光。与 亮度 和 阴影 进行比较。



	Lock(锁定)
	锁定轨道以进行编辑。用一个闭合的锁头图标表示。



	Luma(亮度)
	Luminance(亮度)
	表示图像或视频的亮度。亮度通常与 色度 配对。亮度代表无彩色(aka black-and-white)图像，而色度分量代表颜色信息。



	Markers(标记)
	属于它们创建/用于的剪辑，并与之一起移动。标记的更改适用于时间轴中剪辑的所有副本。请参阅 标记



	Mask(遮罩)
	An area to block out parts of an image. Can be used to apply an effect only to the masked area (see Mask Apply) or to have an underlying clip show through (see Rotoscoping - 转描, Alpha Shapes, Shape Alpha and Rectangular Alpha Mask).



	Master Audio(主音频)
	渲染期间将所有音频轨道合并为一个时的音量。请参阅 效果-音频工具



	Master(主)
	Master Effect(主效果)
	一个特殊效果堆栈，应用于所有轨道中的所有剪辑。



	Media Browser(媒体浏览器)
	Allows easy browsing of the file system and previewing media clips and other assets for importing to the Project Bin. A widget that can be switched on and off via Menu ‣ View ‣ Media Browser. See the chapter media_browser.



	MELT
	melt
	Melt是作为MLT框架的测试工具开发的。如果你愿意，Kdenlive是一个前端，用于编写 .mlt XML文件，该文件编码了编辑点和过渡。然后它调用melt来渲染视频。请参阅 FAQ



	Mixes(混合)
	参看  同轨转场



	Monitor(监视器)
	显示视频信号的设备。Kdenlive使用一个Clip Monitor来播放选定的剪辑 项目素材箱 和 项目监视器 来播放剪辑 时间轴 。监视器是一个可以开关的部件，可以通过 菜单‣查看 。请参阅 监视器.



	MOVIT
	A library for high-quality, high-performance video filters. Is needed to enable GPU-supported preview and playback. See Configure Playback in Menu ‣ Settings ‣ Configure Kdenlive.



	Mute(静音)
	暂时禁用视频或音频轨道。



	Nested Timeline(嵌套时间轴)
	参看 序列



	Opacity(不透明度)
	不透明度是电磁波或其他各种辐射的穿透能力的度量，特别是可见光。任何不透过可见光的对象都是完全不透明的或具有100%的不透明度。



	Out-point(出点)
	出点定义了一个 区域 的结束。区域可以在 时间轴 或 项目监视器 中定义（结果相同），或者在 剪辑监视器 中定义（对剪辑的特定部分进行移动非常有用）。有关可能的用法，请参阅 区域 。



	Overlay(覆盖)
	剪辑监视器和项目监视器可以具有覆盖层，有助于编辑。将鼠标悬停在相应的监视器的热区上（默认情况下为右上角），然后单击网格图标以循环访问可用的模式。与 动态文本 和 视频覆盖层 不同。



	Plane(平面)
	用于  颜色校正 和模糊应用程序，以分离颜色组件，从而仅将效果应用于该组件。颜色分量是RGB（红、绿、蓝）和YUV（亮度（Y）、蓝色投影（U）、红色投影（V））以及alpha（透明通道）。



	Playhead(播放头)
	The upside-down triangle in the timeline ruler. Indicates the (play) position in the timeline. During 3-point Editing determines where a clip or clip zone will be added to the timeline. Drag it across to scrub the timeline.



	Posterize(色调分离)
	Posterization(色调分离)
	是将连续色调或颜色的渐变转换为较少的色调或颜色的区域的转换。该术语来自制作海报的过程。当JPEG图像具有数百万种颜色时，将其转换为仅具有256种颜色的GIF格式时，效果最明显。



	Preset(预设)
	用于 渲染 以确定输出格式（容器）、编解码器、尺寸、宽高比、比特率和各种其他参数。请参阅 渲染参数 。



	Profile(配置文件)
	渲染时请参阅 预设 ，项目时请参阅 项目设置



	Progressive(逐行)
	显示、存储或传输视频的格式，其中每个帧的所有行都按顺序绘制。1080p中的’p’表示该格式使用逐行扫描，即帧的行不是 隔行 。



	Project Bin(项目素材箱)
	Lists all the clips and assets that are associated with the project. Referred to as the ‘Project Tree’ in earlier versions. See the chapter Project Bin.



	Project Monitor(项目监视器)
	项目监视器播放 时间轴 中的剪辑或简单地播放项目。



	Project Settings(项目设置)
	Defines the format (dimensions, aspect ratio, frames-per-second setting) of the project through the choice of profile or preset, which working directory to use, how many video and audio tracks there are initially, and which profile to use for previews. Stores metadata for your project (e.g. title, author, copyright information). See chapter Project Settings.



	Project(项目)
	所有资产、剪辑、轨道、效果、过渡、合成和设置的总和，以及它们在时间轴中的安排，以及对所有源材料的引用，包括它们的 代理 工作副本。项目文件与一个工作目录相关联，Kdenlive在该工作目录中生成代理和缩略图。



	Proxy(代理)
	原始剪辑的轻量级版本。用于简化编辑和播放。请参阅 制作代理剪辑 。



	Quality, custom(品质，定制)
	渲染 对话框中选项部分中的设置，用于控制渲染视频的质量。



	Radio Button(单选按钮)
	用于从选项列表中选择一个选项。就像在旧日里，在收音机上选择预编程的频道：按频道的按钮，之前按的按钮就出来了。



	Rendering Profile(渲染配置文件)
	参看 预设



	Rendering(渲染)
	也被称为“导出”。将编辑后的剪辑保存为单个完整的视频剪辑的过程。请参阅 渲染 。



	RGB Parade
	An RGB parade is a video editing tool (a “scope”) that separates the red, green, and blue color channels of an image in order to analyze their levels and distribution; it is essential for color correction to detect color casts, adjust white balance (ideally, all channels should match), and ensure that no details are clipped in highlights or shadows by graphically displaying the brightness values of each color.



	Ripple Tool(波纹编辑工具)
	用于编辑。更改剪辑的原始持续时间。与使用旧电影材料进行操作进行比较：胶片带被延长或缩短，并因此移动相邻的剪辑。请参阅 时间轴编辑工具 。



	Same-track transition(同轨转换)
	也被称为“混合”。同一轨道上的剪辑之间的转换。请参阅 同轨转换 。



	Saturation(饱和度)
	饱和度是图像或视频中颜色强度的度量。随着饱和度的增加，颜色似乎更加纯粹。与 色调 和 色调 进行比较。



	Sequence(序列)
	在23.04.0版本中引入，序列基本上是一个时间轴。序列是项目的一部分，但可以独立渲染。一个项目可以有多个序列（因此别名为“嵌套时间轴”）。请参阅 序列 。



	Shade(阴影)
	在颜色理论中，阴影是颜色与黑色混合，增加其深度的混合。 色调 与 色调 和 饱和度 进行比较。



	Slip Tool(滑移工具)
	用于编辑。保持剪辑的原始持续时间。与使用旧电影材料进行操作进行比较：胶片带在剪辑长度的给定“窗口”下滑动前后。请参阅 时间轴编辑工具 。



	Snap Point(吸附点)
	Sections in clips that other clips snap to when “snapping” is turned on. Snap points include markers, timeline markers, zone in-points, zone out-points, transition start points, clip edges, and cuts.



	Speed Ramping(速度渐变)
	参看 时间重映射



	Stack(堆栈)
	应用于剪辑、轨道或主效果的列表。效果堆栈从上到下进行处理，因此顺序很重要。请参阅 效果堆栈 。



	Stream(流)
	(编码)媒体文件的一部分，包含视频或音频数据。使用 ffprobe 等工具来检查媒体文件。



	Temperature(温度)
	Color Temperature(色温)
	A parameter describing the color of the visible light source. It is measured in Kelvins (K). The range is from 1,000K to 10,000K where lower temperatures are considered “warm”, and higher temperatures “cool”. See this article about color temperature.

Theme
A set of colors, icons, fonts and other settings to change the appearance of an application or desktop. Can be set from Menu ‣ Settings ‣ Color Scheme.



	Thumbnail(缩略图)
	一个较小的图像表示一个较大的图像。用于在剪辑开始和结束时在时间轴上。请参阅 时间轴-显示视频缩略图 。



	Time Remapping(时间重映射)
	一个特殊的控件，允许对剪辑的速度进行关键帧操作，以实现速度渐变的等效果。请参阅 效果-时间重映射 。



	Timeline Marker (former Guide)
	时间轴 中的静态标记，不一定与剪辑一起移动。不要与 标记 混淆。可用于定义渲染和导出的区域，以便为 YouTube 视频提供章节。参阅 辅助线 。



	Timeline Ruler(时间轴标尺)
	位于轨道的正上方，显示时间码信息（默认标注为 hh:mm:ss:ff，可以切换为帧）以及任何当前定义的时间轴 区域 和/或预览渲染区域。请参阅 时间轴标尺 。



	Timeline Zone(时间轴区域)
	参看 区域



	Timeline(时间轴)
	The central part of Kdenlive. This is where all the editing takes place. Keeps a chronological sequence of the clips and the relations to each other through tracks and compositions. Can be zoomed. See also 序列 for nested timelines.



	Tint(色调)
	在颜色理论中，色调是一种与白色混合的颜色，增加亮度。请比较 阴影 、 色调 和 饱和度 。



	Title Bar(标题栏)
	Part of a widget’s window displaying additional information (e.g. name, title, action icons). You can grab a widget by the title bar and move it around. See 移动小部件.



	Tooltip(工具提示)
	一个小窗口，显示有关图标或按钮的更多信息。将鼠标悬停在图标或按钮上时弹出。按 Shift 键可获取更多详细信息（并非所有功能都可用）。



	Track(轨道)
	Holds various assets in the timeline. Can be muted and locked individually. Can have effects in its own stack that apply to all clips in that track. Track height can be adjusted. Tracks can be inserted and deleted. Video tracks only accept clips with video, image, title, or color; audio tracks only accept pure audio clips or the audio track of a video clip. There is a relationship between video and audio tracks: A video clip with an audio stream can only be put into a track where there is a corresponding audio track - V1/A1, V2/A2, V3/A3 and so on. See 轨道.



	Transcode(转码)
	将视频或音频剪辑从一种格式转换为另一种格式。需要（并且在加载到 项目素材箱 时自动建议）以使文件能够被编辑。请参阅 转码 。



	Transition(过渡/转场)
	A Wipe or Dissolve composition between two overlapping clips. See chapters Compositions-合成 and 转场.



	Tutorial(教程)
	使用函数、工具、效果或这些组合的逐步说明，以实现某种结果。通常以视频和注释或只是说明性文本的形式创建。有很多关于 Kdenlive 的教程可用，可以通过简单的 Google 或YouTube 搜索获得。



	Video Overlay(视频覆盖层)
	Additional information (e.g. timecode) that is overlayed during the render process. Can be selected in the More Options section of the Render Dialog.



	Video Track(视频轨道)
	一个只接受具有视频、图像、标题或颜色的剪辑的轨道类型。需要一个相应的 音频轨道 来接受具有视频和音频 流 的剪辑。请参阅 轨道 。



	Video(视频)
	具有视频 流 的资产或文件。



	Widget(小部件)
	一个由美国剧作家乔治·S·考夫曼在1924年创造的“窗口”和“小工具”的混合词。一个小部件，作为特定  布局 工具或面板的一部分，可以移动到屏幕上的不同位置，并停靠在特定位置，以适应不同的工作流程。请参阅 用户界面 。



	Wipe(擦除)
	A special type of composition mostly used as a transition from one clip to another. See Wipe.



	YCbCr
	用于任何适合于视频和图像压缩和传输格式的 YCbCr 数字编码的色彩空间。有关更多信息，请参阅维基百科页面关于 YCbCr 。



	YIQ
	由模拟 NTSC 彩色电视系统使用的色彩空间。有关更多信息，请参阅维基百科页面关于 YIQ 。



	YPbPr
	一种用于视频电子设备的色彩空间。也写为 Y’PbPr 或 YPBPR。在特别引用组件视频电缆时使用。有关更多信息，请参阅维基百科页面关于 YPbPr 。



	YUV
	一种用于根据人类感知来编码彩色图像或视频的颜色模型。Y 代表 亮度 ，U 代表蓝色投影，V 代表红色投影。



	Zone(区域)
	剪辑或时间轴的定义区域。使用剪辑区域仅将剪辑的一部分带入时间轴。使用时间轴区域仅渲染该部分（请参阅 渲染选定区域 ）。定义一个区域进行预览渲染（请参阅 Timeline Preview Rendering ）。区域由设置 入点 和 出点 定义。



	Zoom(缩放)
	增加或减少细节的水平。您可以使用图标或 Ctrl+wheel 缩放时间轴。剪辑和项目监视器可以通过单击监视器 覆盖层 中的图标或使用 Ctrl+wheel 进行缩放。



	多层菜单
	Sandwich Menu(三明治菜单/多层菜单)
	一种减少混乱并节省屏幕空间的方法。看起来像这个 [image: application-menu]。替换了 Kdenlive 菜单栏。可以使用 Ctrl+M 展开。
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